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This document describes first the installation procedure 
for the single-user version, then the installation procedure 
for the server version.

The installation of the demo version is the same as for 
the commercial version. If you only want to evaluate the 
program, we recommend that you install only the single-
user version, that will give you already a good idea of the 
program’s possibilities.

In the opposite list, click on the topic you are interested in.
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﻿ > Required configuration 

Required configuration
Before you install the software, please check that your computer(s) have the minimal configuration des-
cribed on our web site :

http://www.bibliomaker.ch/en/documentation

http://www.bibliomaker.ch/en/documentation
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Single-user version
This chapter describes the installation process of Biblio-
Maker’s single-user version.

In the opposite list, click on the topic you are interested in.

Required configuration	 2
Installing the single-user version	 4
Demo data file	 6
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Single-user version > Installing the single-user version 

Installing the single-user version
Download the software from our web site http://www.bibliomaker.ch/download-app.

Install the software by launching the downloaded installation program.

Windows macOS

The installation program creates a folder called 
BiblioMaker in C:\Program Files\BiblioMaker\.

The installation program creates a folder called 
BiblioMaker in the Applications folder at the root 
level of the hard disk and put the BiblioMaker 
application inside it.

The setup program creates a shortcut for the 
BiblioMaker application in the Start menu and 
in the task bar.

If you wish, create and put an alias for the 
BiblioMaker program on the Desktop or in the 
Dock.

http://www.bibliomaker.ch/en/download-app
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Single-user version > Installing the single-user version 

Automatic Updates
BiblioMaker includes a function for automatic updates : when an update is available, you are informed 
and can start up the update with a single mouse-click.

Please don’t forget that your antivirus software could disturb a future automatic update and we recommend 
that you minimize this risk, for example by configuring the software so that it does not prevent changes 
in the BiblioMaker folder inside the programs folder. Please read the documentation delivered with your 
antivirus software.

A restrictive configuration of Internet access may also prevent future automatic updates. Check with your 
network administrator to make sure that your computer has an Internet connection and that it can connect 
to our servers located in the following domains :

- *.bibliomaker.ch

- *.microconsulting.ch
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Single-user version > Demo data file 

Demo data file
When you launch the software for the first time, a homepage is displayed that lets you open a demo data 
file containing fictive data, so that you can try the software.

If you want to try the software with the demo data, select the software version and the additional functions, 
then click on Demo version. This homepage is displayed at each software startup, so you can try several 
software configurations.

After the software has been launched, do not hesitate to read the handbook by calling the Consult 
documentation… command in the Help menu.

You can enter data in the demo data file, but don’t enter data «for real». Indeed, if you eventually decide 
to buy the software, you will have to create your own data file and won’t be able migrate to the new file 
the data entered in the demo data file.

The demo data file is 
saved by the software 
in the Documents\
BiblioMaker\ folder 
of the current user 
account.
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Single-user version > Creating the data file 

Creating the data file
If you want to only evaluate the BiblioMaker program, you can skip this step.

If you have decided to buy the software, create the data file you will use. 

Launch BiblioMaker : the homepage is displayed. Click on the New… button in the «Create a new file» 
section. A dialog box is displayed and you can give the data file a name. The data file is saved in the 
Documents\BiblioMaker\ folder of the current user account.

Please note that only the current user will be able to access the data file with the single-user version of 
BiblioMaker. If you want several users of the computer to have access to the data file independently of 
the opened session, please drag it to a shared folder (for instance C:\Users\Public\Public Documents\ 
under Windows or Macintosh HD:Users:Shared under macOS).

The data file cannot be saved in the same folder as the application or in the folder containing the installed 
programs. Don’t save either your data file in a folder shared «in the cloud» (such as Dropbox, One Drive, 
iCloud Drive, etc.), because the synchronization operations of such folders are not compatible with 
BiblioMaker. You could damage your data file or work with a file version that is not updated.

When creating a data file, the program asks for an activation key. This activation key has been given to 
you in the form of a code containing numbers and letters. Enter this code in the registration dialog and 
click on the button Validate key via Internet. The dialog fills up with your complete contact information.



Installation Guide

8

Server version
This chapter describes in a short way the installation 
procedure for the server version 7 of BiblioMaker. It is 
destined to the server administrator, who should have a 
good knowledge of a computer’s use and of its operating 
system.

This document doesn’t address particular cases, such as 
the installation of several BiblioMaker Server programs 
on the same computer, or the use of a BiblioMaker Server 
in a mixed network (network with Macs and PCs under 
Windows).

In the opposite list, click on the topic you are interested in.

Creating the data file	 7
Overview of the installation steps	 9
Installing BiblioMaker Server	 10
Creating the data file	 11
Configuring and startup of BiblioMaker Server	 12
Installing BiblioMaker Client on the server	 22
Copying the Client setup program on a file server	 23
Installing BiblioMaker Client on the client computers	 24
Connecting to the server from the client computers	 25
Technical support	 27
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Server version > Overview of the installation steps 

Overview of the installation steps
The BiblioMaker Server program is installed in several steps:

1.	 Installing BiblioMaker Server

2.	 Creating the data file

3.	 Configuring and startup of BiblioMaker Server

4.	 Installing BiblioMaker Client on the server

5.	 Copying the BiblioMaker Client setup program on a file server

6.	 Installing BiblioMaker Client on the client computers from the file server

7.	 Connecting to the server from the client computers

Steps 1 to 5 are performed on the server, steps 6 and 7 on the client computers.

Before installing the program, please check that you have the following elements :

•	 Installation software for BiblioMaker (downloaded from our web site) :

•	 Installation software for the server version

•	 Installation software for the client version

•	 Activation key for BiblioMaker



10

Server version > Installing BiblioMaker Server 

Installing BiblioMaker Server
Launch the installation program called Install BiblioMaker Server.

Windows macOS

The setup program creates a folder called 
BiblioMaker Server in the C:\Program Files\
BiblioMaker\ folder.

The installation program creates a folder called 
BiblioMaker in the Applications folder at the root 
level of the hard disk and put the BiblioMaker 
Server application inside it.

The setup program creates a shortcut for the 
BiblioMaker Server application in the Start menu 
and on the Desktop.

If you wish, create a shortcut for the BiblioMaker 
Server program and put it onto the Desktop or 
into the Dock. 
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Server version > Creating the data file 

Creating the data file
After the software has been installed, create the data file you will use.

Launch BiblioMaker Server. The program displays a dialog asking you what you want to do. Click the 
Create a new data file… button. Specify the name and location of the new data file.

You cannot save the database in the application folder or in the folder containing the installed programs. 
For instance, create a new folder called BiblioMaker in the Documents folder of the current user. Please 
note that only the current user will be able to access the data file locally on the server : if the data file must 
be accessed by several server administrators, save the data file in commonly accessible folder.

Don’t save the data file in a folder that is shared on the network. Indeed, the data file is shared by the 
BiblioMaker Server application using its own protocol and not Windows’ or macOS’ filesharing protocol. 
By saving the data file in a shared folder, there would be a risk that a user accesses the data file from the 
network using the filesharing function and damages the file.

Don’t save the data file in a folder shared «in the cloud» (such as Dropbox, One Drive, iCloud Drive, etc.), 
because the synchronization operations of such folders are not compatible with BiblioMaker. You could 
damage your data file or work with a file version that is not updated. 
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Server version > Configuring and startup of BiblioMaker Server 

Configuring and startup of BiblioMaker Server
Your computer network must use the TCP/IP protocol. Be default, BiblioMaker Server communicates with 
the following TCP port numbers :

Software Client-server SQL* Reserved* Connection** PHP* HTTP* HTTPS*

BiblioMaker 19813 19812 19814 19819 8002 8080*** 8443

* Not used by default, but reserved by the application. An error message can be displayed by BiblioMaker 
Server when starting up if the port number is already in use by another application.

** Used by the connection dialog on the client side in order to display the server availability (TCP and 
UDP port).

*** The port number for the online catalogue (WebOPAC) can be freely defined.

If a firewall protects your server, open the above mentioned port numbers so that the client computers can 
connect to the server. If you don’t open the TCP ports used by BiblioMaker Server, the client computers 
will be able to «find» the server, but cannot connect to it (error message with Nr -10’002).

In this chapter, the Settings are often mentioned, as they contain many settings. We recommend that you 
change only the mentioned settings and leave the other ones alone, in order not to make the software 
unstable.

You can change 
the TCP port num-
bers used by the 
BiblioMaker Server 
software (read on).
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Server version > Configuring and startup of BiblioMaker Server 

Memory allocation
If more than 5 client computers will connect simultaneously to the server or if the data file size is or will 
be over 500 MB, the memory settings by default should be changed :

Launch BiblioMaker Server (at the first launch, press and keep the Alt key pressed in order to create your own 
data file) and define the cache memory’s size in the Settings>User settings for Data file…, available from 
the File menu (macOS) or Edit menu (Windows). You define the cache’s parameters  under Database > 
Memory tab. 

You can choose between two kinds of settings :

•	 the “forced cache” (the check box Calculation of adaptive cache is not ticked). You define a size for the 
cache memory without taking the available machine resource into account.

•	 the “adaptive mode” (the chex box Calculation of adaptive cache is ticked). The cache memory is 
calculated dynamically depending on the available free memory.

With the adaptive mode, you set up the size of the memory to be reserved for other applications and for 
the system (this memory size is used by the operating system and by other applications running concurrently, 
BiblioMaker Server will not use it for its cache), the percentage of available memory used for cache, its 
maximum and minimum size.

Ideally, the cache memory should be equal to the data file’s size. If the server doesn’t have enough RAM, give a 
smaller amount of cache memory. The cache memory should not be smaller than 1/3 of the data file size.

Resizing the cache memory requires a restart of BiblioMaker Server in order to be taken into account.

NB: the size of your data file is dependent on the data quantity it holds. This size will grow as time goes by. 
When you create the database, the file size is under 5 MB, but it could grow as big as tens or hundreds of 
megabytes. Therefore, it will be necessary to regularly check the cache memory’s size or the total server’s 
RAM and compare it with your data file’s size.

When you call the Set-
tings, please choose 
the User settings for 
Data file, as these 
settings will be saved 
during a software 
update.
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Server version > Configuring and startup of BiblioMaker Server 

Automatic backups
Server versions of BiblioMaker include a backup tool for automating backups.

This backup tool lets you choose between two complementary backup strategies :

•	 Full backup of the data file. This strategy is sufficient if the number of daily changes is not too big.

•	 Incremental backup : all changes brought to the data file, such as adding, modifying and deleting 
records are saved in a log file. This strategy is useful if the number of daily changes is fairly big.
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Server version > Configuring and startup of BiblioMaker Server 

Setting up backups
Launch BiblioMaker Server and if necessary choose the data file to open.

In the Administration window, Maintenance theme, you can check the date and time of the last full backup, 
the date and time of the next full backup and the needed and available space.

Click on Preferences… in order to change the backup settings.

In the Scheduler tab, set up the backups frequency.

In the Configuration tab, define the backup contents. Only the data file and the user structure file need 
to be backed up (the structure file with the .4DZ extension correspond to the BiblioMaker application ; 
should you restore the program, we recommend to download if again and not from a backup).

Define then the path of the backups with the … button (of course, we recommend to save the backups 
on another physical disk than the disk used for hosting the original data file).

In the Backup & Restore tab, define general settings.

If you’d like to set up the second backup strategy (incremental backups), tick in the Configuration tab the 
Use log file check box and define its path on the disk (we recommend that you choose another physical 
disk than the disk hosting the original data file ; nevertheless, avoid file servers : in fact, the log file is 
continually on use and any network interruption would make it useless). The log file sports the name of 
the data file followed by the .journal extension (for instance BiblioMaker.journal).

A log file is always synchronised with a full backup file, as it contains only the changes brought to the data 
file after the last full backup. By the next full backup, the log file is archived and a new log file is created. 
The current log file always sports the same name. On the other hand, the archives of log files sport the 
name of the log file followed by a number, so that you may identify with which full backup a log archive 
is synchronised (for instance BiblioMaker[0004].4BL).

After you have validated the Database properties, a full backup starts automatically.
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Server version > Configuring and startup of BiblioMaker Server 

Each backup file sports the name of the original data file followed by the backup number in brackets and 
then finally the .4BK extension (for instance BiblioMaker[0001].4BK). The backup number is incremented 
by each full backup and lets the administrator quickly find the most recent full backup.
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Server version > Configuring and startup of BiblioMaker Server 

Incremental backups
The incremental backup saves in a second file all changes brought to the data file (adding, modifying 
and deleting of records) since the last full backup. It lets you restore the last full backup and integrate all 
operations that happened after the full backup, until the crash happened. This file is called the log file.

The incremental backup is synchronised with the full backup. This is why it is necessary to setup and 
perform a full backup before setting up an incremental backup.

Activating the incremental backups is described in the previous chapter.

A log file is always synchronised with a full backup file, as it contains only the changes brought to the data 
file after the last full backup. By the next full backup, the log file is archived and a new log file is created. 
The current log file always sports the same name. On the other hand, the archives of log files sport the 
name of the log file followed by a number, so that you may identify with which full backup a log archive 
is synchronised (for instance BiblioMaker[0004].4BL).

Please note that the first archive of a log file sports the number 0000, as the data contained in the first 
log file have been entered before the first full backup.

Restoring a backup
In case of an incident with the data file, you can of course restore a data file backup. Please read the document 
Office Maker/BiblioMaker Administrator handbook.

We recommend that you restore a backup at least one time as an exercise. By doing so, you can check 
that backups are OK and you get the experience if a real incident happens.
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Server version > Configuring and startup of BiblioMaker Server 

Client-Server connections

TCP Port numbers
As a reminder, BiblioMaker Server uses the following TCP port numbers :

Software Client-server SQL Reserved* Connection** PHP* HTTP* HTTPS*

BiblioMaker 19813 19812 19814 19819 8002 8080*** 8443

* Not used by default, but reserved by the application. An error message can be displayed by BiblioMaker 
Server when starting up if the port number is already in use by another application.

** Used by the connection dialog on the client side in order to display the server availability (TCP and 
UDP port).

*** The port number for the online catalogue (WebOPAC) can be freely defined.

These port numbers can be changed in the Settings>User settings for Data file… of BiblioMaker Server, 
under the following themes :

•	 Client-Server
•	 Web
•	 SQL
•	 PHP
Please note that changing the Client-Server port automatically changes also the following ports :
Reserved = Client-server + 1 ; Connection = Client-server + 6.

When you call the Settings, please always choose the User settings for Data file, as these settings will be 
saved when updating the software.
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Server version > Configuring and startup of BiblioMaker Server 

Automatic startup

Windows macOS

BiblioMaker Server can be registered as a service, 
so that the program starts up even if no session 
has been opened on the server.

In the File menu of BiblioMaker Server, select the 
Register as service command.

Notice : if this command is not active, you must 
quit BiblioMaker Server and run the software as 
an administrator (in the Windows Explorer), make 
a right click on the software icon and choose Run 
as administrator).

Then, open the Services app, display the Pro-
perties of the 4D Server:BiblioMaker service. 
Under the General Tab, define the Startup type 
as Automatic. Under the Log on tab, select  an 
account that is not the local system account: we 
recommend to choose the account used by the 
server administrator.

The program will then be launched automatically 
after each computer’s boot. BiblioMaker Server 
will continue to run even after an administrator 
has logged out.

This function does not exist under macOS. You 
can nevertheless configure your server so that 
BiblioMaker Server automatically starts up after the 
login : open the System preferences>Accounts, 
select the corresponding account and in the 
Login items tab, add BiblioMaker Server to the 
list of applications to be started.

You can also configure the computer to automa-
tically open a session when starting up : open 
the System preferences>Accounts and in the 
Login Options, choose the account to open in 
the Automatic login.

If you create the 
user account for the 
occasion, it is essential 
to log in with this 
account and recom-
mended to register 
the service and its 
properties from this 
account.
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Server version > Configuring and startup of BiblioMaker Server 

Power saving
Prevent unwanted disconnections between the server and the clients by setting up the server, so it never 
falls asleep :

Windows macOS

Open the Power management Control panel, set 
the Power schemes on Always on, Turn off hard 
disks on Never and System standby on Never.

Open Energy saver in the System preferences. 
Do not put the computer or the hard disk to sleep. 
Otherwise, the communication with the client 
computers would be interrupted as soon as the 
server falls asleep.

You can activate the 
Display sleep.
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Server version > Configuring and startup of BiblioMaker Server 

Automatic updates
BiblioMaker includes a function for automatic updates : when an update is available, you are informed 
and can start up the update with a single mouse-click.

Please don’t forget that your antivirus software could disturb a future automatic update and we recommend 
that you minimize this risk, for example by configuring the software so that it does not prevent changes 
in the BiblioMaker folder inside the programs folder. Please read the documentation delivered with your 
antivirus software.

With the server version, the information about an update is displayed on a client computer. But if a user 
starts an update, the download and software update are performed on the server. This is why it is important 
the server to have access to the Internet and be able to connect to our web servers :

- *.bibliomaker.ch

- *.microconsulting.ch

Please configure your server and your network (firewall and/or proxy) so that the connections to our update 
server are not blocked.

Under macOS, the Updater application used for updating must have the necessary permissions. In the Sys-
tem Preferences>Security & Privacy>Privacy tab>Full Disk access, add to the list the Updater application 
located under : Macintosh HD:Users:[User name]:Library:Application Support:BiblioMaker:4D:Updater.

During an automatic update, the active connected workstations are warned by a message and have a 
5-minute delay to exit the client application for the cloud versions and a default delay of 10 minutes 
(modifiable by the administrator) for the local servers.
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Server version > Installing BiblioMaker Client on the server 

Installing BiblioMaker Client on the server
We recommend to install the BiblioMaker Client software on the server in order to define some software 
parameters and to access the data file locally. Download the installation program from the BiblioMaker 
web site, then launch it. Then follow the instructions given on screen.

After the software has been installed, launch it and connect to the BiblioMaker Server software. You can 
thus check that the server can be reached from the client computers.

When creating a data file, the program asks for an activation key. This activation key has been given to 
you in the form of a code containing numbers and letters. Enter this code in the registration dialog and 
click on the button Validate key via Internet. The dialog fills up with your complete contact information.

Don’t forget to quit BiblioMaker Client in order to let the client computers connect to the server.

http://www.bibliomaker.ch/download-server
http://www.bibliomaker.ch/download-server
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Server version > Copying the Client setup program on a file server 

Copying the Client setup program on a file server
We recommend to create a shared folder on a file server, folder that will contain the installation program 
for BiblioMaker Client. You will then install the client software over the network.

Copy the BiblioMaker Client installation program (file Install BiblioMaker Client downloaded from the 
BiblioMaker web site) into the shared folder on the file server.

The operations on the server are over. Keep your installation program and activation key should you need 
to repeat the installation process eventually.

––––––––––––––––––––

The following operations are executed on the client computers. You must connect to the file server or 
download the BiblioMaker Client installation program from the BiblioMaker web site.

http://www.bibliomaker.ch/en/download-server
http://www.bibliomaker.ch/en/download-server
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Installing BiblioMaker Client on the client computers
We recommend that you perform this step with an Administrator account.

Copy onto the client computer the setup program for BiblioMaker Client and launch it. By default, a folder 
BiblioMaker Client will be created inside the C:\Program Files folder (Windows) or Applications:BiblioMaker 
folder (macOS). You can create a shortcut (alias) of BiblioMaker Client and put it onto the Desktop, in the 
task bar (Windows) or into the Dock (macOS).
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Connecting to the server from the client computers
Start the BiblioMaker Client software. At the first startup, a wizard is displayed in order to make the 
connection to the server easier. Click on the button I have a local server. The wizard displays the servers 
found on the local network at the specified port number. If the server is available on a different port number, 
enter the port number and click the magnifying glass to search for the server again.

The servers found appear in the list. Select the desired server and click the Next button. Give a name to 
the server (preferably the name of the library) and validate.

If the wizard does not find the server, click the My server is not in the list button. Enter the name of 
the server (preferably the name of the library) and its IP address followed by the port number (such as 
192.168.1.10:19800 or server.mylibrary.ch:19800). Validate.

In the next step, select the Add [server name] to favorites and optionally Show at startup check box if 
you want to have a dialog box for selecting the server every time the client software starts. Finally, click 
the Connect button to connect to the server.

After an update of BiblioMaker Server, the client software will be automatically updated during the 
subsequent connection.



26

Server version > Connecting to the server from the client computers 

Standby of client workstations
BiblioMaker Server tolerates that connected client computers go to sleep. The following points are 
nevertheless important :

•	 The connected client computers can remain in standby mode for a maximum of 24 hours. At the end 
of this period, the server cuts the connection with these computers.

•	 The automatic updates of the server software require a connection interruption and therefore the 
workstations in standby are automatically disconnected. In the cloud version, the server receives security 
updates once a month and software updates are possible any night of the week at 3 a.m.

•	 If records are being modified when the workstation is put to sleep, they remain locked for the other 
stations.

For all these reasons, it is recommended to limit the standby state to short periods (e.g. breaks during 
the day) and to quit the client software every evening.

In the server administration console, on the Users page, it is possible to distinguish between idle and 
active workstations: the Activity column shows «Sleeping» instead of an activity percentage. 



Technical support
In case of an issue, please call our Support 
departement:

From Switzerland :

0900 576 900
(Fr. 3.13/minute from the Swiss landline network)

From Switzerland and abroad :

+41 (0)21 651 77 68
(not overtaxed call,

only for users with an update subscription)

Micro Consulting SA
Chemin de Budron A 12

CH-1052 Le Mont sur Lausanne
Switzerland

Web site : www.bibliomaker.ch

http://www.bibliomaker.ch
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